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RESUMO 
 

 
A capacidade motora força compõem, atualmente, qualquer tipo de treinamento, 

sendo a hipertrofia muscular uma das principais adaptações desejadas, por isso, a 

avaliação desta adaptação se torna fundamental nos estudos. Este trabalho tem por 

objetivo avaliar o efeito de uma única sessão de exercício de agachamento na 

espessura muscular (EM) do quadríceps, utilizando duas metodologias de análise das 

medições: software do ultrassom (U) e o software ImageJ (IMA). A amostra inclui doze 

ciclistas amadores do sexo masculino, que passaram por avaliação física, teste de 

1RM e um exercício de agachamento na barra guiada a 75% de 1RM, com 10 séries 

de 10 repetições e pausas passivas de dois minutos entre as séries. A medição da 

espessura muscular ocorreu em três momentos distintos: pré exercício, 24 horas e 48 

horas após a intervenção. Os resultados demonstram diferenças estatisticamente 

significativas (p < 0,05) entre as medições obtidas pelo U e pelo IMA em todas os 

momentos analisados. Além disso, apenas nas análises do músculo Reto Femoral 

(RF) a nível de 60%, realizadas pelo IMA, foram observados valores superiores da EM 

nos momentos de 24 horas e 48 horas pós exercício (p = 0.012). Os resultados obtidos 

neste estudo indicam que a técnica de análise das imagens da EM do quadríceps, 

obtidas por meio de ultrassonografia (US), pode influenciar nos resultados. 

 
Palavras-chave: ciclismo; protocolo de exercício de força; espessura muscular; 

ultrassom; educação física 



ABSTRACT 
 

 
Motor strength capacity currently encompasses any type of training, with muscle 

hypertrophy being one of the main desired adaptations. Therefore, the assessment of 

this adaptation becomes fundamental in studies. This study aims to evaluate the effect 

of a single squat exercise session on quadriceps muscle thickness (MT), using two 

depth analysis methodologies: ultrasound software (U) and ImageJ software (IMA). 

The sample included twelve male amateur cyclists, who underwent physical evaluation, 

1RM test and a guided barbell squat exercise at 75% of 1RM, with 10 sets of 10 

repetitions and passive pauses of two minutes between sets. Muscle thickness was 

measured at three different times: pre-exercise, 24 hours and 48 hours after the 

intervention. The results demonstrate statistically significant differences (p < 0.05) 

between the observations obtained by U and IMA at all times analyzed. Furthermore, 

only in the analyses of the rectus femoris muscle (RF) at the 60% level, performed by 

IMA, were higher EM values collected at 24 hours and 48 hours post-exercise (p = 

0.012). The results obtained in this study indicate that the technique of analysis of the 

EM images of the quadriceps, obtained by means of ultrasonography (US), can 

influence the results. 

 
Keywords: cycling; strength exercise protocol; muscle thickness; ultrasound; physical 

education 
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1. INTRODUÇÃO 

 
O treinamento de força (TF) tem ganhado destaque devido aos seus benefícios 

para a saúde geral, o desempenho esportivo e o bem-estar físico (UCHIDA et al., 

2020). Um dos objetivos principais desse tipo de treinamento é promover a hipertrofia 

muscular, que contribui tanto para a melhoria da saúde quanto para o aprimoramento 

do desempenho esportivo (Conceição et al., 2012). A hipertrofia ocorre por meio de 

diversos mecanismos, sendo o estímulo gerado pelo protocolo de treinamento de 

força, fator determinante (Uchida et. al., 2020). Além dos efeitos crônicos citados, 

evidências científicas também demonstram que uma única sessão de exercício de 

força pode provocar alterações subagudas nos aspectos metabólicos, hemodinâmicos 

e de estrutura da fibra muscular (micro traumas no tecido muscular e conectivo) 

perceptíveis após o esforço (Umpierre et. al., 2007; Conceição et. al., 2012). 

Nos últimos anos, tecnologias avançadas, como a tomografia computadorizada 

e a ressonância magnética, têm sido empregadas para avaliar com precisão a área de 

secção transversa (AST) e a espessura muscular (EM), possibilitando a mensuração 

das alterações na hipertrofia muscular induzidas pelo treinamento (Pinto et. al., 2022) 

e lesões decorrentes dele, ou seja, das sessões de treinamento. Contudo, essas 

tecnologias apresentam um custo elevado, e como alternativa, a ultrassonografia (US) 

destaca-se por sua praticidade e menor custo em comparação a outros métodos de 

avaliação da hipertrofia muscular, além de sua fácil operacionalização (Ema et al., 

2013a; Franchi et al., 2018a). 

Na década de 1990, foi introduzido o método de US panorâmica, também 

conhecido como "extended field of view" (Weng et. al., 1997). Essa técnica permite a 

captura de imagens ampliadas por meio da movimentação uniforme e contínua do 

transdutor sobre a pele, com aplicação de pressão mínima, e utiliza um software 

específico para renderizar as imagens estáticas (Elliott, 2006; Ahtiainen et. al., 2010). 

A US panorâmica oferece a vantagem de permitir a visualização de porções proximal, 

medial e distal de um músculo ou grupo muscular em uma única imagem (Arruda et 

al., 2022; Oranchuk et al., 2020; Soares; Nogueira; Gomes, 2021). Essa abordagem 

possibilita a análise de adaptações regionais na arquitetura muscular, como a 

hipertrofia seletiva, sem a necessidade de múltiplas imagens. Apesar disso, a técnica 

mais utilizada de US para avaliar a hipertrofia muscular continua sendo no seu modo 
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2D, principalmente devido ao seu baixo custo (Earp et. al., 2015; Ema et. al., 2013a; 

Mangine et. al., 2018; Matta et. al., 2017; Trindade et. al., 2019). 

Tanto para a US panorâmica quanto para o US 2D, fatores como o ângulo e a 

pressão do transdutor sobre a pele podem interferir nos resultados, pois o 

posicionamento inadequado dificulta a detecção dos ecos refletidos (Larivière et al., 

2013a, 2013b). Assim, o posicionamento cuidadoso do transdutor, aliado a descrições 

metodológicas detalhadas, é essencial para garantir a replicabilidade das medidas, 

especialmente em estudos experimentais que exigem avaliações repetidas (Blazevich; 

Gill; Zhou, 2006; Ishida et al., 2018; Arruda et al., 2022; Cleary et al., 2022). Esse rigor 

metodológico é particularmente relevante em pesquisas que investigam o impacto do 

treinamento de força, onde as mudanças observadas podem ser pequenas (Coratella 

et al., 2021; Stock et al., 2016). O método funciona por meio da emissão de ondas 

ultrassônicas de frequências variáveis, que penetram nos tecidos corporais, refletem 

ecos de diferentes impedâncias acústicas e os convertem em sinais elétricos no 

transdutor (O’brien, 2007). 

Vários estudos que utilizam a técnica da US 2D para avaliar a EM, utilizam 

posteriormente às imagens captadas, outro software para a análise final de uma 

provável alteração induzida pelo exercício. O ImageJ, software de código aberto 

destaca-se nestes estudos. Ele oferece ferramentas versáteis para diferentes níveis 

de usuários. Sua interface simples e estável, praticamente inalterada desde os 

primeiros anos, combina com uma flexibilidade que permite personalização e 

extensões para atender necessidades específicas de análises. O programa suporta 

tarefas básicas, como abrir imagens em diferentes formatos, anotar e processar 

imagens, até funcionalidades mais avançadas, como a análise de grandes volumes 

de dados de imagem e a aplicação de algoritmos de aprendizado de máquina. Além 

disso, o ImageJ possibilita medições precisas e a determinação do tamanho de 

estruturas, seja importando informações de tamanho dos metadados da imagem ou 

configurando a escala manualmente. Sua adaptabilidade e recursos abrangentes 

tornam o ImageJ uma ferramenta indispensável em diversas áreas de pesquisa 

(Schroeder et. al., 2021). 

Dentre os diferentes tipos de erro em pesquisa científica, destacam-se o erro 

sistemático e o erro casual, que impactam nas medidas e comprometem as análises 

dos resultados. De acordo com Rodrigues (1956), o erro sistemático ocorre devido a 
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fatores que, ao agirem de maneira constante sobre um instrumento, um processo de 

mensuração ou um operador, afetam os resultados de forma previsível. Já o erro 

casual, conforme o mesmo autor, resulta da influência de diversos fatores que fazem 

com que a diferença entre a medida e a grandeza mensurada ora seja positiva, ora 

negativa, de modo que, quanto maior o número de medidas realizadas, mais essas 

diferenças tendem a se anular, seguindo uma lei de distribuição de probabilidade. 

Além disso, a limitação das análises dos softwares pode comprometer a 

precisão das medições, afetando os resultados. Nesse contexto, justifica-se a 

necessidade de compreender o impacto de diferentes estratégias de avaliação das 

imagens obtidas por meio da técnica de US, comparando os dados fornecidos 

diretamente pelo software do ultrassom (U) com aqueles analisados pelo software 

ImageJ (IMA) em relação aos valores da EM. Essa análise mostra-se relevante, pois 

uma inconsistência milimétrica nas medições pode influenciar a interpretação dos 

resultados e, consequentemente, a avaliação das respostas ao exercício. Assim, a 

pesquisa contribui para o desenvolvimento de análises mais precisas e confiáveis no 

âmbito da avaliação do treinamento físico. 
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2. OBJETIVO GERAL 

 
Avaliar o efeito de uma única sessão de exercício de agachamento na barra guiada 

nas medidas de EM dos músculos Reto Femoral (RF) e Vasto Lateral (VL), 

comparando as medições obtidas diretamente do U e aquelas avaliadas por meio do 

IMA. 

 

 
3. MATERIAIS E MÉTODOS 

 
 

3.1 Delineamento do estudo 

 
Será adotado um estudo do tipo experimental, com praticantes recreacionais 

de ciclismo. Os voluntários foram convidados a participar do estudo por meio de mídias 

sociais dentro da cidade de Ouro Preto e região. O estudo foi aprovado pelo Comitê 

de Ética da Universidade Federal de Ouro Preto, CAAE: 65847422.1.0000.5150 e 

número do parecer: 5.902.367. Este projeto faz parte de um projeto de pesquisa maior. 

Todos os voluntários foram informados de todos os procedimentos que seriam 

realizados ao longo do desenvolvimento da pesquisa, bem como os eventuais riscos e 

benefícios associados à sua participação no estudo. Os voluntários que concordaram 

com tais procedimentos e se enquadravam dentro dos critérios de inclusão, foram 

convidados a formalizar seu consentimento por meio da assinatura de um Termo de 

Consentimento Livre e Esclarecido. 

 
3.2 Característica da amostra 

 
A amostra foi composta por 12 voluntários do sexo masculino, sendo que todos 

eram ciclistas amadores, com idade entre 20 e 44 anos. Os sujeitos engajados na 

pesquisa possuíam uma estatura média de 178,25 cm e massa corporal (kg) média 

equivalente a 76,46 kg. Foram adotados como critérios de exclusão sujeitos: (1) 

menores de 18 anos; (2) que não comparecessem na bateria de testes físicos no dia 

e hora programados; (3) que apresentassem algum tipo de enfermidade que fosse 

comprometer a coleta dos dados; (4) fumantes; (5) que fizessem uso de 

medicamentos como anti-inflamatórios e antibióticos e/ou outros que 

comprometessem os dados da pesquisa; (7) indivíduos que utilizassem suplementos 

que interfira na recuperação muscular e (8) por livre e espontânea vontade do 
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voluntário. Já como critério de inclusão, bastava os indivíduos serem saudáveis e 

praticantes de ciclismo há 1 ano e competindo há 6 meses. 

 

 
3.3 Protocolo de exercício de força 

 
O exercício de força selecionado para este estudo foi o agachamento na barra 

guiada. Inicialmente, todos os voluntários foram submetidos ao teste de anamnese e 

o teste para avaliar a força máxima, definida como a capacidade de executar uma 

repetição máxima (1-RM) (Miranda et. al., 2019). Após essa primeira etapa, passava- 

se 14 dias após a realização do teste de 1-RM, e então os participantes eram 

orientados a evitar qualquer tipo de exercício físico por 48 horas antes da intervenção. 

Este protocolo, adaptado de Byrne e Eston (2002), consistia em executar 10 séries, 

com a meta de realizar 10 repetições em cada série utilizando 75% de 1-RM. O 

intervalo entre as séries foi de 120 segundos. Os voluntários realizaram o exercício de 

agachamento até atingir um ângulo de 90° e seguiram um ritmo de execução que 

incluía 1 segundo na fase concêntrica e 3 segundos na fase excêntrica (Armstrong et. 

al., 2022) para que a repetição fosse considerada válida. Dessa forma, os voluntários 

foram submetidos a medição da EM pelo ultrassom no quadríceps, pré exercício, 24 

horas e 48 horas após a intervenção. As coletas de dados foram realizadas sempre 

num mesmo horário, período noturno. 

 

 
Fonte: Google imagens 
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3.4 Instrumento 

 
Para a análise dos dados da EM do músculo RF e VL, foi utilizado um aparelho 

de US portátil (Mobissom) equipado com um transdutor linear (Modelo M2D®), 

multifrequencial de 7,5 MHz e 10 MHz. Um protocolo padronizado (incluindo a 

colocação do transdutor de forma perpendicular, marcos anatômicos em nível 

muscular de 40% (RF) e 60% (RF e VL) e posição do sujeito deitado em decúbito 

dorsal, foi definido pelo mesmo examinador. Também incluiu configurações de 

ultrassom (frequência de 10 MHz, ganho de 100dB, profundidade de 60mm) que foram 

mantidas constantes entre os sujeitos e em todos os períodos. Todas as medições de 

imagem foram realizadas por um único examinador, usando o U, assim como também 

avaliado os dados pelo IMA (NIH, Bethesda, MD, EUA). Valores médios foram usados 

como representativos da espessura dos músculos RF e VL. A EM, expressa em mm, 

foi definida como a distância da interface do tecido adiposo subcutâneo à interface 

músculo-osso. (SIQUEIRA et al., 2018). 

 
O aparelho realizado para a US pode ser visualizado na FIG. 1. 

 

 
Figura 1 – Ultrassom portátil linear (Modelo M2D®) 

Fonte: Mobissom 
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3.5 Processos para medição – Ultrassom 
 
 

A medição da musculatura que compõem o quadríceps pela US segue uma 

cronologia de procedimentos: 

1. O examinador solicita ao indivíduo que se sente na maca, com os joelhos 

fletidos a 90° e em posição neutra. 

2. Em seguida, utilizando uma fita antropométrica, mede-se o comprimento do 

quadríceps, tomando como referência a região lateral da coxa e considerando 

a distância entre o trocânter maior e o epicôndilo lateral do fêmur. 

3. Com base nessa referência, marca-se 60% do comprimento total da lateral da 

coxa e, a partir dessa medida, acrescenta-se 3 cm medialmente (sentido 

anterior da coxa) para definir a referência do VL. 

4. Após essa marcação, acrescenta-se mais 6 cm medialmente (sentido anterior 

da coxa) para determinar a referência do RF a 60%. 

5. Para obter a referência do RF a 40%, repete-se o procedimento anterior, mas 

acrescenta 9 cm medialmente (sentido anterior da coxa). 

6. Para garantir a replicação exata da localização das imagens nas avaliações 

subsequentes, realiza-se todas as marcações utilizando um pincel indelével, 

assegurando maior precisão nas três coletas realizadas: pré exercício, 24 horas 

e 48 horas após a intervenção. 

7. Em seguida, solicitou-se ao voluntário que se deite na maca em decúbito dorsal, 

com o joelho em extensão máxima e rotação neutra. 

8. Para permitir o contato acústico sem pressionar a superfície dérmica, aplicou- 

se um gel de transmissão solúvel em água na sonda de ultrassom. 

9. Após obter uma imagem de qualidade satisfatória, manteve-se a captura para 

análise posterior da EM do respectivo músculo. 

10. Todas as imagens capturas pelo U, foram salvas em um tablet modelo Galaxy 

Tab S6 Lite 64GB da marca Samsung. 
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Figura 2 – Software do ultrassom (U) portátil linear (Modelo M2D®) 

 

 

 

 

Figura 3 – Medição do músculo Reto Femoral (RF) (pontilhado branco com círculo na parte superior da figura) a 

nível de 40% pelo Software do ultrassom (U). 
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3.6 Processos para medição – ImageJ 
 

 
O software de acesso público ImageJ 1.43a, versão 64 bits (National Institutes of 

Health, Bethesda, EUA; https://imagej.net/ij/), desenvolvido em Java e compatível com 

a maioria dos sistemas operacionais (Carmona et al., 2007), processa e analisa as 

imagens. No presente estudo, o pesquisador instala o software em um computador 

com processador AMD Ryzen 5 5600X® (Ryzen Corporation, EUA), 32 GB de 

memória RAM e sistema operacional Windows 10®, de 64 bits (Microsoft Corporation, 

EUA). 

A medição pelo IMA ocorre em um local e momento distintos da medição feita pelo 

U, seguindo a seguinte cronologia de procedimentos: 

 
1. Instalação do IMA no computador. 

2. Após a instalação e o acesso ao software, segue-se o seguinte passo a passo: 

3. Calibração do software utilizando uma imagem de uma folha A4 com um risco 

de caneta preta, marcando 10 cm medidos com régua. 

4. Clicar em File > Open (ou arrasta e solta a imagem para calibrar). 

5. Seleciona o ícone da "mão" e, em seguida, clica no ícone de "traço na diagonal 

para a direita". 

6. Realizar um traço sobre a marcação da imagem, exibindo uma linha amarela 

para medir o comprimento, e o software calcula automaticamente a distância 

em pixels. 

7. Com o risco amarelo na imagem, clicar em Analyze > Set Scale > Known 

Distance (digita 10 no espaço) > Unit of Length (digita cm no espaço) e confirma 

em "OK". O software recalcula o número de pixels por centímetro 

automaticamente. 

8. Após a calibração, o software fica pronto para iniciar as medições de todas as 

imagens coletadas pelo ultrassom. 

9. Abrir a imagem a ser medida clicando em File > Open (ou arrastando e soltando 

a imagem no software). 

10. Realizar um traço vertical sobre o músculo a ser medido, respeitando todos os 

padrões de referência. 

https://imagej.net/ij/
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11. Em seguida, clicar em Analyze > Measure, e o software calcula 

automaticamente o comprimento em centímetros. 

 
 

 

Figura 4 - Software do ImageJ (IMA) 1.43a 

 

 

 

Figura 5 - Medição do músculo Reto Femoral (RF) (linha amarela) a nível de 40% pelo Software do ImageJ (IMA) 

1.43ª. 
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3.7 Análise Estatística 
 
 

Inicialmente serão analisados os pressupostos para escolha de estatística 

paramétrica ou não paramétrica sendo estes: Teste Shapiro Wilk e de Levene. Para a 

comparação entre os valores analisados pelos diferentes softwares (U e IMA) a cada 

momento de medida utilizou-se o Teste t de Student para medidas pareadas. Para 

avaliação do comportamento das medidas ao longo do tempo (pré exercício, 24 horas 

e 48 horas após a intervenção) foi realizada a análise de variância de um fator (One- 

Way), exceto para o músculo RF com medida analisada a nível de 60% pelo IMA, que 

apresentou valor de p = 0.034 no teste de Shapiro-Wilk. Neste caso foi realizada uma 

análise não paramétrica de Kruskal-Wallis. Para todas as análises adotou-se como 

nível de significância p ≤ 0,05. 
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4. RESULTADOS 

 
 

Na TAB. 1, tem-se os resultados expressos em média e desvio padrão para a 

caracterização da amostra, como idade (anos), massa corporal (kg), estatura (cm), 

IMC (kg/m2), massa corporal (kg), massa muscular (kg), gordura corpora (kg), peso 

alcançado no exercício de agachamento (1RM), tempo de competição (anos), volume 

semanal de treinamento (km). 

 
Tabela 1: Caracterização da amostra   

Características Média DP 

Idade (anos) 33.58 8.21 

Estatura (cm) 178.25 7.26 

IMC (kg/m2) 23.96 1.73 

Massa corporal (kg) 76.46 10.14 

Massa muscular (kg) 35.73 4.64 

Gordura corporal (kg) 13.47 5.34 

1RM no Agachamento (kg) 102.17 11.30 

Tempo de competição (anos) 6.58 7.89 

Quantidade semanal de treinamento (km) 241.25 98.03 

Legenda: cm = Centímetros. kg/m2 = Quilograma por metro ao quadrado. kg = Quilograma. 1RM = Uma 

repetição máxima. km = Quilômetros. 

 

O presente estudo avaliou a EM do RF e do VL em diferentes momentos e 

níveis musculares, utilizando duas análises distintas de avaliação: U e IMA. Para 

garantir uma melhor qualidade das análises estatísticas, inicialmente foi realizado o 

teste de normalidade de Shapiro-Wilk (TAB. 2), que indicou que todas as amostras 

apresentaram distribuição normal. Dessa forma, optou-se pelo teste t para amostras 

pareadas, permitindo a comparação direta entre os dois métodos de avaliação. 
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Tabela 2: Teste à Normalidade (Shapiro-Wilk) 

U 
 

IMA W p 

RF 40% pré U - RF 40% pré IMA 0.877 0.080 

RF 60% pré U - RF 60% pré IMA 0.926 0.340 

VL 60% pré U - VL 60% pré IMA 0.886 0.105 

RF 40% 24h U - RF 40% 24h IMA 0.898 0.151 

RF 60% 24h U - RF 60% 24h IMA 0.902 0.168 

VL 60% 24h U - VL 60% 24h IMA 0.917 0.259 

RF 40% 48h U - RF 40% 48h IMA 0.968 0.890 

RF 60% 48h U - RF 60% 48h IMA 0.919 0.275 

VL 60% 48h U - VL 60% 48h IMA 0.886 0.105 

Legenda: Um p < 0.05 sugere violação do pressuposto da normalidade. U = Software do Ultrassom. IMA = 

Software ImageJ. RF = Reto Femoral. VL = Vasto Lateral. 

 
Os resultados das comparações, entre as duas estratégias de análise (U e IMA), 

a cada momento de medida (pré exercício, 24h e 48h após a intervenção) estão 

apresentadas na TAB. 3. As comparações apresentaram valores estatisticamente 

significativos para todas as medidas realizadas (p < 0,05) entre os diferentes 

softwares, para cada momento. A comparação da medição foi realizada considerando 

dois níveis musculares correspondentes a 40% e 60% para o RF e 60% para o VL 

(distância entre o trocânter maior e o epicôndilo lateral do fêmur). 
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Tabela 3: Teste t para amostras emparelhadas 

 

 

 

 

Local de Medida 

Muscular 

 

Momento da 

Medida 

 

 

U 

cm 

 

 

IMA 

cm 

 

 

p 

 

RF 40% 

 

 

 

RF 60% 

 

Pré 

 

 

 

Pré 

 

1.97±0.487 

 

 

 

1.43±0.260 

 

2.89±0.928 

 

 

 

1.90±0.335 

 

< .001 

 

 

 

< .001 

 

 

VL 60% 

 

 

Pré 

 

 

2.02±0.331 

 

 

2.78±0.554 

 

 

< .001 

 

 

RF 40% 

 

 

24h 

 

 

1.98±0.330 

 

 

3.14±0.603 

 

 

< .001 

 

 

RF 60% 

 

 

24h 

 

 

1.55±0.376 

 

 

2.50±0.690 

 

 

< .001 

 

 

VL 60% 

 

 

24h 

 

 

2.06±0.335 

 

 

3.26±0.564 

 

 

< .001 

 

 

RF 40% 

 

 

48h 

 

 

2.04±0.432 

 

 

3.25±0.771 

 

 

< .001 

 

 

RF 60% 

 

 

48h 

 

 

1.52±0.328 

 

 

2.35±0.418 

 

 

< .001 

 

 
VL 60% 

 

 
48h 

 

 
2.10±0.264 

 

 
3.20±0.532 

 

 
< .001 

 

 

Legenda: Hₐ μ Medida 1 - Medida 2 ≠ 0. U = Software Ultrassom. IMA = Software ImageJ. RF = Reto Femoral. VL = 

Vasto Lateral. cm = centímetros. 
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A média do desvio-padrão e do coeficiente de variação (desvio padrão para U 

= 0,35 e para IMA = 0,60 e coeficiente de variação para U = 19,09% e para IMA = 

21,32%) das medições indicam uma maior variação das médias quando utilizado o 

IMA. Valores mais baixos do desvio-padrão e do coeficiente de variação demonstram 

maior homogeneidade dos dados avaliados. 

Na FIG. 6, tem-se o comportamento das medidas analisadas ao longo do 

tempo, para as diferentes técnicas de análises das imagens, nos diferentes pontos de 

referência muscular. Não foram observadas diferenças estatísticas significativas 

quando analisado os valores das EM ao longo do tempo. Exceto para o músculo RF 

avaliado por meio do IMA a nível de 60% da distância entre o trocânter maior e 

epicôndilo lateral do fêmur (p = 0.012). 
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C D 

 

 

E F 

 
 

 

Figura 6 – Valores médios da Espessura Muscular (EM) nos momentos pré, 24h e 48h após uma única sessão de 

exercício de força nos músculos Reto Femoral (RF) a 40% e 60% e Vasto Lateral (VL) a 60%, analisados pelo 

software do ultrassom (U) e pelo software ImageJ (IMA). * p < 0.05 em relação ao momento Pré-exercício (Pré). 
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4. DISCUSSÃO 
 

 
Este estudo teve como objetivo, avaliar o efeito de uma única sessão de 

exercício de força (exercício de agachamento na barra guiada) nas medidas de EM 

dos músculos RF e VL, comparando as medições obtidas diretamente do U e aquelas 

avaliadas por meio do IMA. Para uma melhor discussão sobre a importância deste 

estudo, foi realizada uma busca pelos registros nas bases de dados PubMed, Scielo, 

Portal Periódico da Capes e Google Acadêmico utilizando as palavras-chave: 

“ultrassom” and “espessura muscular”, dando preferência para os artigos publicados 

a partir do ano de 2020. Dentre os diversos registros encontrados, foram selecionados 

50 estudos (2 de classificação A1, 2 de classificação A2, 1 de classificação A3, 12 de 

classificação B1, 9 de classificação B2, 2 de classificação B3, 5 de classificação C, 3 

trabalhos de conclusão de curso, 5 teses de mestrado e 9 teses de doutorado), para 

leitura e análise dos dados. 

Após a análise do título, resumo e da metodologia utilizada em cada um dos 

registros, foi organizada uma planilha contendo informações como: autor(es) e ano, 

título, desenho do estudo, características da amostra, EM, vínculo com exercício físico 

ou não, e tipo de software utilizado para análise das imagens. Dentre os estudos 

selecionados, 30 utilizaram o próprio U para a avaliação da imagem captada, 19 

utilizaram o IMA e 1 (classificação C) utilizou o software Image-Pro, sendo 

desconsiderado no estudo por ser software distinto dos analisados neste estudo. Além 

disso, 10 dos 30 registros que utilizaram o U estavam relacionados ao exercício físico. 

Por outro lado, 13 dos 19 registros que utilizaram o IMA estavam vinculados ao 

exercício físico. O resumo dos registros selecionados para o estudo está apresentado 

na FIG. 7. 
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Figura 7 - Representação gráfica da quantidade de estudos que utilizaram o U e IMA vinculado ao exercício físico 

ou não vinculado ao exercício físico. 

 

Dos 49 registros analisados, foram selecionados dois artigos, a título de 

exemplo, que utilizam o U e dois artigos que utilizam o IMA, todos vinculados ao 

exercício físico. Os participantes desses estudos eram predominantemente homens 

fisicamente ativos e saudáveis, sendo a musculatura do quadríceps a região analisada 

para a medição da EM. As características dos estudos incluídos estão resumidas nos 

QUADROS 1 e 2. 
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Quadro 1: Visão geral dos estudos elegíveis com IMA e exercício físico 

 

Autor(es) e 

ano 

 

SIQUEIRA, Angelina Freitas et al. 2018 

 

DOURADO, Marco et al. 2023 

 

Título 

Multiple Cold-Water Immersions Attenuate Muscle 

Damage but not Alter Systemic Inflammation and 

Muscle Function Recovery: 

A Parallel Randomized Controlled Trial 

Different time course recovery of 

muscle edema within the quadriceps 

femoris and functional performance 

after singlevs multi-joint exercises 

 

Desenho 

 

Estudo paralelo randomizado controlado 
Delineamento contrabalanceado 

unilateral e contralateral 

Tamanho da 

amostra 

 

n = 30 

 

n = 14 

 

Participantes 

 

Homens fisicamente ativos 

 

Homens jovens saudáveis 

 

Espessura 

muscular 

 

Reto femoral e vasto intermédio 

 

Reto femoral e vasto lateral 

 

Protocolo de 

Exercício 

1. Cinco séries de 20 saltos de queda de uma 

caixa de 60 cm com dois minutos de descanso entre as 

séries 

2. Salto vertical explosivo máximo 

 

Testes máximo de dez repetições 

(10RM) 

Tipo de 

software 

utilizado 

 

ImageJ 

 

ImageJ 
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Quadro 2: Visão geral dos estudos elegíveis com U e exercício físico 

 

Autor(es) e 

ano 

 

PADILHA, Ubiratan Contreira et al. 2020 
CARVALHO, Maurício Tatsch 

Ximenes et al. 2019 

 

 

Título 

 

 

Respostas neuromusculares e metabólicas do método de 

treinamento de força FST-7 em homens treinados 

Efeitos do exercício passivo precoce 

em cicloergômetro na espessura 

muscular do quadríceps 

femoral de pacientes críticos: estudo- 

piloto randomizado controlado 

Desenho --- Ensaio clínico piloto randomizado 

Tamanho da 

amostra 

 

n = 10 

 

n = 24 

Participantes Homens com experiência em treinamento de força 
Ambos os sexos, com idade superior 

a 18 anos 

 

Espessura 

muscular 

 

Reto femoral e vasto intermédio 

 

Quadríceps femoral 

 

 

 

 

Protocolo de 

Exercício 

1) FST-7 (sete séries de 10 repetições de extensão 

unilateral de joelho com 30s de intervalo entre as séries, 
sendo 20 - 25s de alongamento do quadríceps; 

2) CON (sete séries de 10 repetições de extensão 

unilateral de joelho com 30 s de intervalo entre as séries 

sem alongamento); e 

3) TRAD (sete séries de 10 repetições de extensão 

unilateral de joelho com 120s de intervalo entre as séries 

sem alongamento). O trabalho total consistiu no 

somatório do que foi realizado nas sete séries de 10 
repetições (joules). 

 

 

Cicloergômetro no modo passivo, 

com o paciente em decúbito dorsal e 

elevação da cabeceira a 30º, por 20 

minutos, cadência fixa de 20 

ciclos/min, uma vez ao dia 

Tipo de 

software 

utilizado 

 

Ultrassom 

 

Ultrassom 
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Ao analisarmos os dados dos estudos dos 49 artigos, que utilizaram tanto o U 

quanto o IMA para avaliar diferentes grupos musculares, em indivíduos saudáveis e 

não saudáveis, observou-se que 14 estudos utilizaram o U sem associação a 

protocolos de exercício e em pessoas com condições de saúde específicas, enquanto 

2 estudos utilizaram o IMA para a mesma finalidade. Essas pesquisas abrangeram 

músculos como masseter, temporal, bíceps, braquial, RF, VL, vasto medial, tibial 

anterior, diafragma e gastrocnêmio medial. Outros 6 estudos empregaram o U em 

indivíduos saudáveis, enquanto 4 utilizaram o IMA, analisando músculos como 

diafragma, tríceps, bíceps, subescapular, abdominal, supra ilíaca, axilar média, tórax, 

coxa, panturrilha, masseter, temporal, VL, RF e gastrocnêmio medial. 

Ao incluir o exercício físico na análise e manter a distinção entre indivíduos 

saudáveis e não saudáveis, os resultados revelaram uma distribuição relativamente 

equilibrada entre as análises. A literatura consultada aponta 3 estudos com o U e 2 

com o IMA para indivíduos não saudáveis submetidos ao exercício, enquanto para 

indivíduos saudáveis, 7 estudos utilizaram o U e 12 utilizaram o IMA. Conforme o 

levantamento realizado nestes estudos (49 artigos), com as palavras-chave: 

“ultrassom” and “espessura muscular”, esses dados sugerem que o U aparece mais 

frequentemente em pesquisas com indivíduos não saudáveis, enquanto o IMA é mais 

aplicado a estudos que envolvem indivíduos saudáveis, vinculados a protocolos de 

exercício. 

Os resultados do presente estudo indicam que a medição da EM do quadríceps 

varia conforme o método empregado, evidenciando a influência da técnica na 

interpretação dos dados. As medições realizadas pelo IMA apresentaram valores 

superiores às obtidas diretamente do U. Essa diferença pode estar associada às 

características específicas de cada análise de medição, incluindo a forma como os 

algoritmos do ImageJ detectam interfaces musculares e como o ultrassom capta 

imagens em tempo real. 

Outro achado relevante envolve o aumento da EM ao longo do tempo, 

especialmente 24 e 48 horas após a intervenção, observado somente na análise do 

músculo RF a nível de 60% pelo IMA. Alterações na EM, podem ser observadas após 

um exercício de força como sendo parte de uma resposta inflamatória (edema 

muscular) induzido pelo treinamento de força, sugerindo que o protocolo adotado 

induziu adaptações musculares temporárias (SILVA, Fernando Oliveira Catanho da; 
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MACEDO, Denise Vaz., 2011). Entretanto, esta diferença foi observada somente em 

uma das avaliações, ou seja, somente para um método de análise específico. Tal fato 

pode sugerir uma influência importante na análise dos dados de acordo com o 

software utilizado, podendo provocar erros de interpretação de dados (Rodrigues, 

1956). 

Apesar dos resultados observadas, ambas as análises se apresentam como 

válidas para avaliar a EM, cada uma com vantagens e focos de estudos diferentes. A 

US destaca-se pela praticidade e pelo baixo custo operacional, sendo amplamente 

utilizado na prática clínica e científica. Por outro lado, o ImageJ permite análises mais 

detalhadas e reprodutíveis, favorecendo estudos que demandam alta precisão na 

medição. As diferenças sistemáticas entre as formas de análises reforçam a 

necessidade de padronização dos protocolos de medição para garantir maior 

comparabilidade dos resultados conforme o público-alvo do estudo. 



 

6. CONSIDERAÇÕES FINAIS 30 

Os resultados obtidos neste estudo indicam que a técnica de análise das 

imagens da EM do quadríceps, obtidas por meio da US, pode influenciar nos 

resultados. Este estudo contribui para uma maior reflexão em relação as metodologias 

de avaliação da EM, auxiliando pesquisadores e profissionais da área na escolha do 

método mais adequado para suas análises. Pesquisas futuras podem explorar outras 

variáveis que influenciam as medições e investigar novas tecnologias para aumentar 

a precisão na mensuração das adaptações musculares ao treinamento de força. 
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